I/0 Editor User Guide o
/ Q\ MICROCHIP

I nt I'Od u CﬁOn (Ask a Question)

The I/0 Editor displays all assigned and unassigned I/0 macros and their attributes in a spreadsheet-like
format. Use the I/0 Editor to view, sort, filter, select, and set I/0 attributes of the SmartFusion 2, IGLOO 2,
RTG4™, or PolarFire device.

The 1/0 attributes can be viewed by port name or by package pin. Click the Ports View tab to view I/0 attributes
by port name. Click the Pin View tab to view /O attributes by pin name.

The 1/0 Editor provides the following views for I/0 assignment and planning:
+ Port View—I/O spreadsheet sorted by port name

+ Pin View—I/O spreadsheet sorted by pin number

+ Package View—Package pin graphical view of the device

Notes: The following views are also available:

*  Memory View—I/O view specific to the memory interface

+ 10D View—I/0O view specific to the IOD Lane Controller interface

+  XCVR View—I/0 view specific to the transceiver interface

* Floorplanner View—Detailed cell-level device view of the entire chip
+ Netlist Viewer - Hier View—Post-synthesis hierarchical view

+ Netlist Viewer - Flat View—Post-compile flattened netlist view

Note: This user guide shows a PolarFire device in the example figures.


https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-E78D5FFC-5EE9-4357-B323-0C2542D77E05&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=Introduction
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1. InVOking the I/O EditOI‘ (Ask a Question)

The design must be in the post-synthesis state before the I/0 Editor can be invoked. A warning
message appears if the /0 Editor is invoked in the pre-synthesis state.

The I/0 Editor can be invoked in two ways from the Constraint Manager:

+ Design Flow window > Manage Constraints > Open Manage Constraints View > Constraint
Manager > I/0 Attributes > Edit > Edit with 1/0 Editor

+ Design Flow window > Manage Constraints > Open Manage Constraints View > Constraint
Manager > 1/0 Attributes > View

The Edit with 1/0 Editor option in the Constraint Manager allows you to save or commit your
changes to PDC files, whereas the View option shows the post-Place and Route design including the
final placement and the I/0 attributes in read-only mode. You cannot save or commit any changes
made in the I/0 Editor opened using the View option.

However, you can export and save the physical constraints using File > Export Physical Constraint
(PDC) in both options and save them. These constraints can later be used in your design as input
files, depending on the design's requirement.

The I/0 Editor opens with view tabs across the top of the graphical interface, as shown in the
following figure.

Figure 1-1. I/0O Editor
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@1nr0: Reading User BDC file D:/Designs_Proj/vl12_2/exl/designer/top/top.nmatinit.txt. 0 error(s)

and 0 warning(s)

Fam: Polarfire | Die; MPFLOOT | Pla: FCSG325
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2. PO rt View (Ask a Question)

The Port View displays the I/0 attributes in a spreadsheet-like format. Each row corresponds to an
I/0 port in the design, sorted by the port name. The column headings specify the names of the I/0
attributes in your design. The first few column headings are standard and common for all families.
The remaining columns display family-specific attributes. Only attributes applicable to a specific
device appear in the I/0 Editor attributes table. For some I/0O attributes, you will choose from a
drop-down menu; for others, you might enter a value and for others, the field is read-only and not
editable.

Displayed columns can be sorted alphabetically, numerically, or filtered.

In the 1/0 Editor, the ports can be viewed in a spreadsheet-like format or in the Design Tree View
window of the Port tab. A port selected in the Port tab is also selected in the Port View spreadsheet
and vice versa. The following figure shows the DM[0] selected in the spreadsheet and the Design
Tree port view.

The Port View also displays the memory width and data rate of the DDR instance in the design (if
it exists in the design) in the top left row under the Port Name column, as shown in the following
figure.

Figure 2-1. Port View
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Notes: See the following documents for more information about the I/0 standards supported by
each attribute:

« PDC Commands User Guide for SmartFusion2, IGLOO2, and RTG4
+ PDC Commands User Guide for PolarFire FPGA

2.1. Port Name (Ask a Question)
This is the port list of the design. The ports of the design are displayed in a structured manner
according to group name/functions. Ports can be expanded or collapsed. The port list can be sorted
or filtered, in a way similar to the Windows spreadsheet operations. For example, entering RESET in
the match field in the filter returns a list of port names that have RESET in the port name.

2.2. Direction (Ask a Question)
Non-editable field that denotes Input, Output, or Inout.
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2.3.

2.4.

2.5.

2.6.

2.7.

2.8.

2.9.

2.10.

2.11.

I/O Sta nda rd (Ask a Question)

This field specifies the I/0 standard the device supports. Different I/0 types have different I/0
standards. The pull-down list displays the valid I/O standards for that particular type of I/O0s. The list
of valid I/0 standards is limited to what the 1/0 bank (to which the I/0 belongs) can support.

Pin Number (Ask a Question)
This is the package pin number specific to the die and package of the device.

LOCked (Ask a Question)
If checked, the current pin assignment cannot be changed during layout.

Macro Ce" (Ask a Question)
This is a read-only field that identifies the name of the Macro cell associated with the Port.

Bank Name (Ask a Question)

This is a read-only field to identify the I/0 bank the I/0 pin is associated with. Depending on the
device size, devices may have, six, or eight I/0 Banks (Bank 0 through Bank 7) user I/O banks. Each
pin is associated with an I/0 bank. The I/0 banks on the north side of the device support only HSIO.
Each 1/0 bank has dedicated I/0 supplies and grounds. Each I/0 within a given bank shares the
same VDDI power supply, and the same VREF reference voltage. Only compatible I/0 standards can
be assigned to a given I/0 bank.

User 1/O Lock Down (aska question)

If checked, the pin is controlled by the Tamper macro |0_Disable signal. When Tamper |O_Disable is
asserted, the selected I/0 pin is disabled. Inputs are disabled and detected as a logic low by FPGA
fabric. Outputs are tri-state with any configured pull-up or pull-down still honored.

Note: This is applicable for PolarFire and PolarFire SoC families only.

I/O State in FIaSh*Freeze MOde (Ask a Question)

By default, all I/Os become tri-stated when the device goes into Flash*Freeze mode. You can
override this default behavior by setting one of the following two values:

+ LAST_VALUE—When set to this value, it preserves the previous state of the I/0. This means
the I/0 remains in the same state in which it had functioned before the device went into
Flash*Freeze mode.

« LAST VALUE_WP—When set to this value, it preserves the last value with weak pull-up.
Note: This I/0O attribute is applicable for SmartFusion 2 and IGLOO 2 families only.

Clamp DiOde (Ask a Question)

PolarFire devices have internal PCI clamp diodes for both HSIO and GPIO. PCl clamp diodes help
reduce the voltage level at the input, and are mainly used when the voltage overshoot exceeds the
maximum allowable limit. If signaling levels of the receiver are greater than the VDDIx of the bank,
the clamp diode must be off to support hot-socketing insertion.

For GPIO, use this field to program the clamp diode to be ON or OFF.
For HSIO, the internal clamp diode is always ON by default.

ResiStOI' Pu" (Ask a Question)

Use this field to allow the inclusion of a weak resistor for either pull-up or pull-down of the input or
output buffer. The available options are None, Up (pull-up), Down (pull-down), or Hold. The default
value is Up.

Note: Not all I/0O standards have a selectable resistor pull option.
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2.12.

2.13.

2.14.

2.15.

2.16.

2.17.

2.18.

1/0 Available in Flash*Freeze Mode (ask question)

Use this field to indicate if the /O is available or unavailable in Flash*Freeze mode. The default value
is No and the I/0 is unavailable in Flash*Freeze mode.
Note: This I/0 attribute is applicable for SmartFusion 2 and IGLOO 2 families only.

Use 1/0 Calibration from the Lane (ass question)

The Use I/0 Calibration from the Lane option supports the PolarFire and PolarFire SoC devices.
This feature allows you to configure 1/0 to opt-out of recalibration. Use this feature either to delay or
sequence calibration themselves or to account for VT impact on I/O performance. Default is OFF.

If you open an old design and you open the I/0 Editor, you will not see this option. You must re-run
compile to see the option.

Note: The Use I/0 Calibration from the Lane option is not supported for ES and XT devices.

SChmitt Trigger (Ask a Question)

GPIO and HSIO can be configured as a Schmitt Trigger input. When configured as ON, it exhibits a
hysteresis that helps to filter out the noise at the receiver and prevents double-glitching caused by
noisy input edges. Default configuration is OFF (Schmitt Trigger disabled).

Vem Input Range (aska question)

Use this field to set the Vcm input range.

Direction: Input

Note: This field is valid for PolarFire and PolarFire SoC devices only.

On-Die Termination (askaquestion)

On-Die Termination (ODT) is an option used to terminate input signals in PolarFire devices.
Terminating input signals helps to maintain signal quality, save board space, and reduces external
component costs. In SmartFusion 2, IGLOO 2, RTG4, and PolarFire FPGAs, ODT is available in receive
mode and also in bidirectional mode when the I/0 acts as an input. If ODT is not used or not
available, the I/0 standards may require external termination for better signal integrity.

ODT can be a pull-up, pull-down, differential, or Thévenin termination with both static and dynamic
control available, and is set using either the Libero® SoC software 1/0 attribute editor or by using a
PDC command.

In addition, ODT can be controlled dynamically for individual I/Os as well as for all I/Os in a lane
simultaneously on a per-lane basis.
ODT Static (Ask a Question)

On-die termination (ODT) is the technology where the termination resistor for impedance matching
in transmission lines is located inside a semiconductor chip instead of on a printed circuit board.
Possible values are listed in the following table.

Table 2-1. ODT Static Values and Descriptions

on Yes, the termination resistor for impedance matching is located inside the chip.

off No, the termination resistor is on the printed circuit board.

ODT Dynamic (Ask a Question)
Note: This option is supported for RTG4 production devices only.

This option is used to opt in or out of the dynamic ODT set on a bank. Possible value are listed in the
following table.
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2.19.

2.20.

2.21.

2.22.

Table 2-2. ODT Dynamic Values and Descriptions

ODT_STATIC=On ODT_DYNAMIC=0n Illegal

ODT_STATIC=On ODT_DYNAMIC=0ff The ODT resistor is always turned on.

ODT_STATIC=0Off ODT_DYNAMIC=0ff The ODT resistor is always turned off.

ODT_STATIC=0ff ODT_DYNAMIC=0n The ODT resistor is on or off based on the ODT Dynamic bank setting.

The following I/0 standards are supported:

+ LVDS

+ RSDS

*  MINILVDS
+ LVPECL
+ HSTLI

« HSTLI

+ SSTL15I
+  SSTL15II
+ SSTL18I
+ SSTL18lII
+ HSTL18I
+ HSTL18II
+ LPDDRI
* LPDDRII

Note: There is a known issue in the Libero SoC I/0 Editor and the pin report. A software limitation
exists where a design cannot have different values for the P and N sides. Currently, both must have
the same value. Libero SoC does program the P and N side correctly for programming. In 1/0 Editor
or pin report, if RES_PULL is Up on both, it means the N side is programmed as Down or vice versa.
ODT Value (Ask a Question)

If the ODT option is turned on, the ODT Value (ohm) field can be set to any one of the values in the
pull- down list. The ODT Value varies with different I/0 standards.

ODT Imp (Ohm) (Ask a Question)

Port Configuration (PC) bits are static configuration bits set during programming to configure the
I/0(s) as per your choice. See your device data sheet for a full range of possible values.

LOW Power EXit (Ask a Question)

For single-ended 1/0s, the Lower Power Exit value can be set from the drop-down list. The supported
values for single-ended 10s are Off, Wake On Change, Wake On 0, Wake On 1. The default is Off.

The diff I/Os are marked as read-only fields and will be set to off.
Input Delay (Ask a Question)
Sets the Input Delay.

Input Delay applies to all I/0 standards. The range of values supported varies depending on the
device selected. The default value is OFF.

Note: This attribute will not appear in the I/0 attributes and cannot be used in the PDC for some
I/0s with dynamic delays, such as DDR I/Os.
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2.23.

2.24,

2.25.

2.26.

2.27.

2.28.

2.29.
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SIeW (Ask a Question)

The slew rate is the amount of rise or fall time an input signal takes to get from logic low to logic
high or vice versa. It is commonly defined to be the propagation delay between 10% and 90% of

the signal's voltage swing. The I/0 Editor supports slew rate control in non-differential output mode.
Turning the slew rate on results in faster slew rate, which improves the available timing margin.
When slew rate is turned off, the device uses the maximum slew rate for the I/0 standard to reduce
the impact of simultaneous switching noise (SSN). By default, the slew control is OFF. Not all I/0
standards support the slew rate control.

Pre-EmphaSiS (Ask a Question)

The pre-emphasis rate is the amount of rise or fall time an input signal takes to get from logic low to
logic high or vice versa. It is commonly defined to be the propagation delay between 10% and 90%
of the signal's voltage swing. The following table lists the possible values.

Table 2-3. Pre-emphasis Rate Values and Descriptions

NONE Sets to none (default)
MIN Sets to minimum
MEDIUM Sets to medium

MAX Sets to maximum

Output Drive (Ask a Question)

Use the Output Drive (mA) field to set the output drive strength. The output drive strength that can
be set is different with different I/0 standards and can vary from 1 mA to 20 mA. Select the drive
strength value from the list of valid values in the pull-down list.

Impedance (aska question)

Use the Impedance (Ohm) field in the 1/0 Editor to program the output impedance values. The
Impedance value is different with different I/0 standards and can vary from 22Q to 240Q. Click on
the Impedance (Ohm) field to open a pull-down list containing valid values.

Output Load (Ask a Question)

The Output Load (pF) field indicates the output capacitance value based on the I/0 standard. If
necessary, you can double click on the respective I/0 port to change the output capacitance value to
improve timing definition and analysis. Output capacitance affects output propagation delay.

SmartTime, Timing-driven layout, and Backannotation automatically use the modified delay model
for delay calculations.

Source Termination (askaquestion)

The Source Termination (Ohm) field is the Near End termination for a differential output I/0. The
default is OFF.

Direction: Output

Output Delay (aska question)

Sets the Output Delay.

Output Delay applies to all I/0 standards. The default value is OFF.
Direction: Output

Note: This attribute will not appear in the I/0 attributes and cannot be used in the PDC for some
I/0s with dynamic delays, such as DDR I/Os.


https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-832368DE-A6EF-475B-B1B0-EC5B735FEE8D&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=Slew
https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-730F3AED-4B9F-41D7-9F91-512071B17579&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=Pre-Emphasis
https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-9907257D-1B09-44C8-B919-4BC79CE1F6DF&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=Output%20Drive
https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-F43851B4-CE82-41B6-B3A7-D6106A626D1C&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=Impedance
https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-01893D19-78A8-4177-8988-93225D73FB3F&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=Output%20Load
https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-FCDCF986-28CB-4AE8-AAB4-DA9E24E4C89F&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=Source%20Termination
https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-654E74E8-2939-444D-9FD1-16BFD8DE5690&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=Output%20Delay

3.1.

3.2

3.3.

3.4.

3.5.

Pi n View (Ask a Question)

The Pin View displays the I/0 attributes of I/0 attributes in a spreadsheet-like format. Each row
corresponds to an I/0 macro (port) in the design, sorted by pin number. The column headings

specify the names of the I/0 attributes in your design. The first few column headings are

standard and common for all families. The remaining columns display family-specific attributes.
Only attributes applicable to a specific device appear in the I/0 Editor attributes. For some 1/0
attributes, you will choose from a drop-down menu; for others, you may enter a value and for the

rest, the field is read-only and not editable.

The display in the columns can be sorted alphabetically, numerically or filtered. See the following

figure.

Figure 3-1. Pin View
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Notes: See the following documents for more information about the I/0 standards supported by

each attribute:

+ PDC Commands User Guide for SmartFusion2, IGLOO2, and RTG4

« PDC Commands User Guide for PolarFire FPGA

Pin Number (Ask a Question)

This is the read-only package pin number specific to the die and package of the device.

PO rt Na me (Ask a Question)

This is an editable field for the assignment of a port to that particular pin number. It contains a
pull-down list of the assignable and available Ports for the pin. Select Unassigned to leave the pin

unassigned.

Direction (Ask a Question)
Non-editable field that denotes Input, Output, or Inout.

|V|aCl'0 Ce" (Ask a Question)

This is a read-only field that identifies the name of the macro cell associated with the port.

Bank Na me (Ask a Question)

This is a read-only field to identify the I/0 bank the /0 pin is associated with. Devices may five,

six, or eight user /0 banks (Bank 0 through Bank 7), depending on the device size. Each pin is
associated with an I/0 bank. The I/0 banks on the north side of the device support only HSIO. Each
I/0 bank has dedicated I/0 supplies and grounds. Each 1/0 within a given bank shares the same
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3.6.

3.7.

3.8.

3.9.

3.10.

3.11.

3.12.

3.13.

VDDI power supply, and the same VREF reference voltage. Only compatible I/O standards can be
assigned to a given I/0 bank.

Fu nction (Ask a Question)

The function name identifies the functions of the pin/port. This is the same as what is listed in the
Public Pin Assignment Table (PPAT) for the selected device and package. For details, see the device
data sheet of the die/package.

The function name may contain the following information:
+ Type of I/0: GPIO or HSIO

+ Special-purpose I/0s (for example, XCVR)

+ The I/0 Bank Number

+ Positive/Negative Pad of differential 1/0s

+ VSSor Ground

LOCkEd (Ask a Question)
If checked, the current pin assignment cannot be changed during layout.

User Reserved (as«a question)

For the I/0 pin you want to reserve for use in another design, check the User Reserved checkbox to
reserve it. When a pin is reserved, you cannot assign it to a port.

Dedicated (Ask a Question)

If checked, the pin is reserved for some special functionality, such as UJTAG, Power, XVCR Reference
Clock, device reset, and clock functions.

VI'Ef (Ask a Question)

Any GPIO and HSIO pad on the device can be configured to act as an external VREF to supply all
inputs within a bank. Use this field to configure the I/0 as VREF to other I/0Os. When an I/0 pad
is configured as Vref (voltage referenced), all I/0 buffer modes and terminations on that pad are
disabled.

User I/O LOCk DOWI’] (Ask a Question)

If checked, the pin is controlled by the Tamper macro I10_Disable signal. When Tamper IO_Disable is
asserted, the selected I/0 pin is disabled. Inputs are disabled and detected as a logic low by FPGA
fabric. Outputs are tri-state with any configured pull-up or pull-down still honored.

Note: This is applicable for PolarFire and PolarFire SoC families only.

1/0 State in Flash*Freeze Mode (asa question)

By default, all I/Os become tri-stated when the device goes into Flash*Freeze mode. You can
override this default behavior by setting one of the following two values:

+ LAST_VALUE—When set to this value, it preserves the previous state of the I/0. This means
the I/0 remains in the same state in which it had functioned before the device went into
Flash*Freeze mode.

+ LAST VALUE_WP—When set to this value, it preserves the last value with weak pull-up.
Note: This I/0O attribute is applicable for SmartFusion 2 and IGLOO 2 families only.

Clamp DiOde (Ask a Question)

PolarFire devices have internal PCI clamp diodes for both HSIO and GPIO. PCl clamp diodes help
reduce the voltage level at the input, and are mainly used when the voltage overshoot exceeds the
maximum allowable limit. If signaling levels of the receiver are greater than the VDDIx of the bank,
the clamp diode must be off to support hot-socketing insertion.
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3.14.

3.15.

3.16.

3.17.

3.18.

3.19.

For GPIO, use this field to program the clamp diode to be ON or OFF.

For HSIO, the internal clamp diode is always on by default.

RESiStor PUII (Ask a Question)

Use this field to allow inclusion of a weak resistor for either pull-up or pull-down of the input or
output buffer. The available options are None, Up (pull-up), Down (pull-down), or Hold. The default
value is None.

Note: Not all I/0 standards have a selectable resistor pull option.

1/0 Available in Flash*Freeze Mode (asks question)

Use this field to indicate if the I/O is available or unavailable in Flash*Freeze mode. The default value
is No and the I/0 is unavailable in Flash*Freeze mode.
Note: This I/0O attribute is applicable for SmartFusion 2 and IGLOO 2 families only.

SChmitt Trigger (Ask a Question)

GPIO and HSIO can be configured as a Schmitt Trigger input. When enabled as such (YES), it exhibits
a hysteresis that helps to filter out the noise at the receiver and prevents double-glitching caused by
noisy input edges. Default value is OFF.

Vem Input Range (askaquestion)

Values for all I/0 standards are MID and LOW. The default is MID.
Note: This field is valid for PolarFire and PolarFire SoC devices only.

On-Die Termination (askaquestion)

On-Die Termination (ODT) is an option used to terminate input signals in PolarFire devices.
Terminating input signals helps to maintain signal quality, save board space, and reduces external
component costs. In PolarFire FPGAs, ODT is available in receive mode and also in bidirectional
mode when the I/0 acts as an input. If ODT is not used or not available, the I/0 standards may
require external termination for better signal integrity.

ODT can be a pull-up, pull-down, differential, or Thévenin termination with both static and dynamic
control available, and is set using either the Libero SoC software I/0 attribute editor or by using a
PDC command.

In addition, ODT can be controlled dynamically for individual I/0s as well as for all I/0Os in a lane
simultaneously on a per-lane basis.

ODT Static (Ask a Question)

On-die termination (ODT) is the technology where the termination resistor for impedance matching
in transmission lines is located inside a semiconductor chip instead of on a printed circuit board.
The following table lists the possible values.

Table 3-1. ODT Static Values and Descriptions

on Yes, the termination resistor for impedance matching is located inside the chip.
off No, the termination resistor is on the printed circuit board.
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3.20. ODT Dynamic (Ask a Question)

Note: This option is supported for RTG4 production devices only.
This option is used to opt in or out of the dynamic odt set on a bank. Possible value are listed in the
following table.

Table 3-2. ODT Dynamic Values and Descriptions

ODT_STATIC=0On ODT_DYNAMIC=0n lllegal

ODT_STATIC=On ODT_DYNAMIC=0ff The ODT resistor is always turned on.

ODT_STATIC=0Off ODT_DYNAMIC=0ff The ODT resistor is always turned off.

ODT_STATIC=0ff ODT_DYNAMIC=0n The ODT resistor is On or Off based on the ODT Dynamic bank setting.

The following I/0 standards are supported:

+ LVDS

+ RSDS

*  MINILVDS
+ LVPECL
* HSTLI

+ HSTLH

+ SSTL15I
+ SSTL15II
+ SSTL18I
+ SSTL18II
+ HSTL18I
+ HSTL18II
* LPDDRI
+ LPDDRII

3-21. ODT Value (Ask a Question)

If ODT option is turned on, the ODT Value (Ohm) field can be set to any one of the values in the
pull-down list. The ODT Value varies with different I/0 standards.

Values vary depending on the I/0 standard.
3.22. ODT Imp (Ohm) (Ask a Question)

On-die termination (ODT) is the technology where the termination resistor for impedance matching
in transmission lines is located inside a semiconductor chip instead of on a printed circuit board.

Port Configuration (PC) bits are static configuration bits set during programming to configure the
I/0(s) as per your choice. See your device datasheet for a full range of possible values.

3.23. LOW Power EXit (Ask a Question)

For single-ended 1/0s, the Lower Power Exit value can be set from the drop-down list. The supported
values for single-ended |0s are Off, Wake On Change, Wake On 0, and Wake On 1. The default is Off.

The differential I/0s are marked as read-only fields and will be set to off.

3.24. Input Delay (Ask a Question)
Sets the Input Delay.

Input Delay applies to all I/0 standards. The range of values supported varies depending on the
device selected. The default value is OFF.

@ MICROCHIP


https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-0C2A41AB-D0FD-468E-8FCD-DAE3F27A5C0C&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=ODT%20Dynamic
https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-2DE3A87E-69A9-4B13-8591-DEA67EA64A04&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=ODT%20Value
https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-CC10A5C3-D043-4478-A3C4-87328996C934&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=ODT%20Imp%20%28Ohm%29
https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-D0A886C7-34BB-49A7-9890-8C4CCB131011&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=Low%20Power%20Exit
https://www.microchip.com/askaquestion?pub_guid=GUID-994FFD14-5666-4A2B-A959-90E89CD4EA3E&pub_lang=en-US&pub_ver=20&pub_type=User%20Guide&bu=fpga&tpc_guid=GUID-57AB72C8-7941-4037-B3C8-7D622A6A6DBB&cover_title=I%2FO%20Editor%20User%20Guide&tech_support_link=NA&revision_letter=Q&source=PDF&title=Input%20Delay

Note: This attribute will not appear in the I/0 attributes and cannot be used in the PDC for some
I/Os with dynamic delays, such as DDR I/Os.

3.25. SleW (Ask a Question)

The slew rate is the amount of rise or fall time an input signal takes to get from logic low to logic
high or vice versa. It is commonly defined to be the propagation delay between 10% and 90% of the
signal's voltage swing. The I/0 Editor supports slew rate control in non-differential output mode.

Turning the slew rate on (either by setting it to ON in the I/O Editor or in a PDC file) results in a

slew rate limited for the I/0 standard in the device. When the value for SLEW in the I/0 Editor or
PDC command is (chosen) OFF, the device uses the maximum slew rate for the 1/0 standard to
reduce the impact of simultaneous switching noise (SSN). Not all I/0 standards support the slew rate
control.

Note: Slew rate control is not available in PolarFire HSIO buffers. However, these buffers have
built-in PVT- compensated slew rate controllers for optimized signal integrity.

3.26. Pre-EmphaSiS (Ask a Question)

The pre-emphasis rate is the amount of rise or fall time an input signal takes to get from logic low to
logic high or vice versa. It is commonly defined to be the propagation delay between 10% and 90%
of the signal's voltage swing. Possible values are shown in the following table.

Table 3-3. Pre-emphasis Values and Descriptions

NONE Sets to none (default)
MIN Sets to minimum
MEDIUM Sets to medium

MAX Sets to maximum

3-27- Output Drive (Ask a Question)
Use the Output Drive (mA) field to set the output drive strength. The output drive strength that
can be set is different with different I/0 standards and can vary from 1 to 20 mA. Select the drive
strength value from the list of valid values in the pull-down list.

3.28. Impedance asaquestion)

Use the Impedance (Ohm) field in the 1/0 Editor to program the output impedance values.
Impedance values are different for different I/0 standards, and can vary from 22Q to 240Q. Use
the pull-down list to select the desired Ohm value.

3.29. Output Load (Ask a Question)

The Output Load (pF) field indicates the output capacitance value based on the I/0 standard. If
necessary, you can double click on the respective I/0 port to change the output capacitance value to
improve timing definition and analysis. Output capacitance affects output propagation delay.

SmartTime, Timing-driven layout, and Backannotation automatically use the modified delay model
for delay calculations.

3.30. Source Termination (asaquestion)

The Source Termination (Ohm) field is the Near End termination for a differential output I/0. The
default is OFF.

Direction: Output

3.31. Output Delay (Ask a Question)
Sets the Output Delay.
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Output Delay applies to all I/0 standards. The range of values supported varies depending on the
device selected. The default value is OFF. The default value is OFF.

Direction: Output

Note: This attribute will not appear in the I/0 attributes and cannot be used in the PDC for some
I/Os with dynamic delays, such as DDR I/Os.
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4- PaCkage View (Ask a Question)

The Package View displays the Package pin views of the particular die/package of the PolarFire
device. The color for the display of the pins are determined by the settings in Display Options. The
following figure shows the regular pins in green, special pins in blue, reserved pins in red, and
unconnected pins in grey.

Figure 4-1. Package View
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5. Interface—Specific 1/0s and Views (s auestion)

The PolarFire architecture is designed and optimized to support Memory interface, 10D interface,
and Transceiver interface. The I/0 Editor for PolarFire provides three special views specifically for 1/0
assignments of these interfaces.

For optimal Quality of Result (QOR) and timing performance, the architecture of the PolarFire silicon
requires the Memory Interface, IOD Interface and Transceiver Interface be placed in specific and
pre-defined locations of the chip. Assignment of these interfaces are checked against PolarFire DRC
rules and illegal assignments are flagged.

The I/0 Editor is a Graphical User Interface (GUI) tool designed to make Interface I/0 pin
assignments graphically and user-friendly, as an alternative to writing PDC commands. When the
pin assignment is committed and saved in I/0 Editor, a PDC file is created. This PDC file can then be
passed to the Place and Route tool as a Physical Design Constraint.

5.1. Interface—Specific 1/O Views s« question)

In addition to the Pin view, Port view and Package view, the I/O Editor provides three views specific
to PolarFire-supported interfaces I/0s:

+  Memory View—for I/0O pin assignments of Memory interfaces such as DDR3/4, LPDDR3, and QDR.

+  XCVR View—Presents a physical view of the Transceiver connectivity, including Transceiver lanes,
Reference Clock (REFCLK), and Transmit PLL lines.

+ 10D Lane Controller View—Presents the I/0 Digital block view, used for non-memory interfaces
using the FPGA I/0s.

Figure 5-1. 1/0O Editor—XCVR View
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6.1.

6.2.

Memory Interface View «a question)

The Memory Interface view presents a spreadsheet-like view of the 1/0s available in the PolarFire
silicon for different Memory interface types.

Memory Type (Ask a Question)
The supported Memory Interface types include:

+ DDR3

+ DDR4

* LPDDR3
+ QDRI+

Use the pull-down menu to select the type of Memory Interface used in the design. Only the specific
type of memory used in the design are displayed in the pull-down list.

The Ports view also displays the memory width and data rate of the DDR instance in the design (if
it exists in the design) in the top left row under the Port Name column, as shown in the following
figure.

Figure 6-1. Memory Interface Type Menu
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Edge_Anchors for Memory Placement (aska question)

The PolarFire silicon architecture requires that the Memory interface be placed in specific and
pre-defined locations of the chip to achieve optimal QOR and timing performance. These specific
location are called Edge_Anchors and are used to identify the specific location in the PolarFire

chip for optimal Memory Interface I1/0 placement. See the PolarFire Family Memory Controller User
Guide for a mapping of DDR memory interface types to Edge_Anchor locations. The Edge_Anchors
are as follows:

« NORTH_NE
+ NORTH_NW
+ SOUTH_SE
+ SOUTH_SW
.+ WEST_NW
« WEST_SW

The ports for each Edge_Anchor is represented by a different color for easy identification. The list
of possible Edge_Anchors is context-sensitive to the Memory Interface type and represents the legal
and optimal locations for the specific Memory interface type. The list of Edge_Anchors for DDR4, for
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example, is different from the list for DD2/DDR3. DDR4 has fewer locations (Edge_Anchors) for I/0
placement than DDR2/DD3.

6.3. Memory Interface View Columns (aska question)

The Memory Interface view detects the type of Memory Interface in the design and presents the
ports in the Ports View. The Memory Interface view displays the following I/0 information in the
view. Each of the column can be sorted (ascending/descending order) or filtered:

« Port Function—Formal port name of the Memory Interface. The ports specific to the memory
interface type are loaded into the Port View.

+ Port Name—Port name of the Memory Interface instance in the design.
* Pin Number—Package pin number assigned to the port of the Memory Interface.

+ Function—More descriptive function name of the Port, which identifies the type of I/0 (for
example, HSIO for High-speed 1/0s or GPIO (General-purpose Input/Output).

+  Max Memory Width—Maximum memory width of the DDR. This is a fixed read-only value specific
to the Edge_Anchor and is different with different Edge_Anchors.

+ Max Data Rate—Maximum data rate in Mbps. This is a fixed read-only value specific to the
Edge_Anchor and is different with different Edge_Anchors.

Notes: When making DDR placement, see the memory width and data rate of the DDR Memory
used in the design (as displayed in the Ports View). Make sure that the Edge_Anchor location, where
you want to place the DDR memory, can accommodate the DDR memory in terms of the memory
width and the data rate. This will avoid invalid placement.

+ Bank Name—the I/0 bank name of the port
+ High-speed I/0 Clocks—specifies the number of High Speed 1/0 clocks

The Pin Number and Function are the same as what are listed in the PPAT for the selected device
and package. The PPAT for each PolarFire package are provided in the PolarFire_<package> Pinouts
file on the PolarFire Documentation web page.

The following figure shows memory interface view.
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Figure 6-2. Memory Interface View
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6.4. Making I/O Assignments (ask question)

To make 1/0 assignment for the Memory Interface instance in the design:

1. Select the Memory Interface type from the drop-down menu.

2. From the Ports tab in the Design Tree View, drag the Memory Interface instance and let the
mouse hover over one of the Edge_Anchor locations available for the Memory Interface type. A
tooltip reports whether it is a legal or illegal location for the Interface instance.

3. Drop the Interface instance into a legal Edge_Anchor location.

Note: DRC rules are enforced. Drag-and-drop 1/0 placement that violates the DRC rules are
reported in the Log window. For Memory Interface, the DRC checks the Data Width and the Data
Rate compliance*. If the specific location cannot accommodate the Data Width or the Data Rate
of the Memory interface, no I/0 assignment is made. An error is reported in the Log Window
with a message that explains why the assignment is not accepted. In the following figure, the DRC
error message reports that the ddr3 instance requires 64 ports, but the SOUTH_SE location can
accommodate only 58 pins.

Note: *Data Rate compliance will be enforced in a later release.

Figure 6-3. DRC Checks in Log Window

@ Errors i, Warnings o Info

@Error: Mempry Interface "top 0/ddr3 x32 0" cannot be placed at location 'S0UTH SE'. Port 'DQ[23]' has no assignment
available for this location

rror: Memory Interface "top 0/ddr3 %32 0" cannot be placed at location "SOUTH SE'. Port 'DQ[23]' has no assignment
available for this location

rror: Memory Interface "top_ 0/ddr3 x32 0" cannot be placed at location "SOUTH SE'. Port 'D{[23]' has no assignment
available for this location
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4. Check that no DRC error messages are reported in the Log window and the I/0 assignments
are accepted (see the following figure). The Lock icon in the Ports tab indicates that the I/0
assignment is accepted and locked.

Figure 6-4. Memory Interface Assignments Accepted
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6-5- IO_PDC File (Ask a Question)

When the I/0 assignment is committed and saved in the I/O Editor, the assignment is saved in a PDC
file in the <project_folder/constraints/io/user.pdc> file. The PDC file contains set_io commands on
each of the DDR Memory Interface 1/0.

The following figure shows PDC file generation after Memory interface I/0 assignment in the 1/0
Editor.
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Figure 6-5. PDC File Generation after Memory Interface I/0O Assignment in |/O Editor

set_io -port name {DQ[24]}
-pin name AG11
—fixed true
-0ODT_VALUE 60
~DIRECTICHN INOUT

set_io -port name {DQ[25]}
-pin name AH11
—fixed true
~DIRECTICHN INOUT

set_io -port name {DQ[26]}
-pin name AG12
—fixed true
~DIRECTICHN INOUT

set_io -port name {DQ[27]}
-pin name AH12
—fixed true
~DIRECTICHN INOUT

set_io -port name {DQ[28]}
-pin name AJ10
—fixed true
~DIRECTICHN INOUT

set_io -port name {DQ[29]}
-pin name AJ11
—fixed true
~DIRECTICHN INOUT

6.6. Removing I/O Assignments (aska question)
To remove a DDR Memory Interface 1/0 assignment:
1. Select the Port tab in the Design Tree view.
2. Right click the Memory Interface in the Design Tree view.

Select Unplace <memory_interface_name> .
See the following figure.
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Figure 6-6. Removing Memory Interface I/0 Assignment
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7. XCVR View (Ask a Question)

The XCVR View allows the user to make assignments for Transceiver Lanes, Reference Clocks and
Transmit PLLs. It presents the following views:

+ A schematic view of the Reference Clock (REFCLK), the TransmitPLL, and the Transceiver Lanes
they drive. See Figure 7-1.

« A graphical placement view of the REFCLK, its connection from the PADS, to the TransmitPLL, to
the Transceiver Lanes. See Figure 7-2.

+ ASignal Integrity View for a Transceiver Lane, showing TX Emphasis Amplitude, TX Impedance,
TX Transmit Common Mode Adjustment, RX and TX Polarity, RX Insertion Loss, RX CTLE, RX
Termination, RX P/N Board Connection, and RX Loss of Signal Detector (Low and High). See Figure
7-3.

Figure 7-1. XCVR Interface—Schematic View
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Figure 7-2. XCVR Interface—Graphical Placement View
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7.1.

7.2.

Figure 7-3. 1/0O Editor—XCVR View—Signal Integrity View
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The Signal Integrity View for a Transceiver Lane shows the following:

«  TX Emphasis Amplitude

+ TXImpedance

+ TXTransmit Common Mode Adjustment

+ RXand TX Polarity, RX Insertion Loss, RX CTLE

+ RXTermination

+ RXP/N Board Connection

+ RXLoss of Signal Detector (Low, High, Calibration, and CDR Gain)

XCVR Interface 1/0 Assignment (aska question)

To make XCVR Interface 1/0 assignment, use the XCVR view in the I/0 Editor to make assignment in
the following order:

1. Transceiver Lanes

2. TXPLL

3. REFCLK

Direct Versus Cascaded Connection (aska auestion)

The PolarFire XCVR reference clock network provides rich connectivity to the TX_PLL and Transceiver
lanes. The connectivity allows the user to share common reference clock inputs to reduce fanout
buffers on the board and reduce costs.

The two types of connections between the reference clock and the TX _PLL and Transceiver lanes
are as follows:

* Direct Connection
+ Cascaded Connection

Direct connections are used when the reference clock pin and the TX_PLL or the Transceiver lanes
are in the same Quad location. Cascaded connections are used when the reference clock pin and
the TX_PLL or the Transceiver lanes are not in the same quad location. Cascade connections are only
available going from the top of the device towards the bottom. The cascaded connection is denoted
in the XCVR view by the black vertical line down the middle of the placement view.
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Note: A REFCLK can connect to all the lanes beside or below it in any quad (down the cascade path)
but not those above it (up the cascade path).

The red lines denote cascaded REFCLK connection to the TX_PLL and the Transceiver lanes in the
quad.

Connection/Assignment up the Cascade path (from REFCLK to TX_PLL and Transceiver lanes which
are above the REFCLK) are illegal and indicated by red lines in the XCVR view.

Each Reference Clock (REFCLK) has a direct dedicated connection to its corresponding TX_PLL and to
the lane that the TX_PLL drives in the same quad.

Selecting a dedicated connection or a cascaded connection depends on the trade-off you want to
make. A direct dedicated connection from the REFCLK to the TX_PLL gives better signal integrity for
the Transceiver whereas a cascaded connection reduces external components and reduces overall
power.

The following figure shows direct dedicated path and cascade path.

Figure 7-4. Direct Dedicated Path and Cascade Path
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7.3.

The following figure shows XCVR view.

Figure 7-5. XCVR View
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Reference Clock (REFCLK) 1/O Assignments (ask question)

To make 1/0 assignments, click and drag the REFCLK pin from the Schematic View to the pin location
you desire in the Graphical Placement View. If the assignment is legal (no DRC violations), green lines
appear to denote the accepted connection between the REFCLK pin through the Q(x)_TXPLL_SSC to

the Transceiver lanes.

Figure 7-6. Legal and Accepted Reference Clock I/O Assignment
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If the 1/0 assignment violates the DRC rule, the assignment is not accepted. Red arrows denotes DRC
violations. The following figure shows two illegal assignments:

*  From the Reference Clock (REFCLK) to the Lanes (Red arrow from REFCLK to the Q2_Lane0)
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P R e |
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*  From the Transmit PLL to the lanes (Red arrow from TXPLL_SSC to Q2_Lane0)
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Figure 7-7. lllegal I/O Assignment
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An error message appears in the Log window to identify the DRC rules violated. In this case, there
is no feasible dedicated connection from the REFCLK to the Lane and from the Transmit PLL to the
Lanes.

Figure 7-8. Log Window Message

Log

&3 Errors i, Warnings i Info

eINFC-.‘ Reading User PDC file G:/PF_media/pf lab/pf lab/constraint/ic/user.pdc. 0 errcr(s) and 0 warning(s)
eINFC-: Reading User PIX G:/PF_media/pf_lab/pf_ lab/constraint/io/tmp extra cst_528463.pdc. 0 error(s) and 0 warning(s)
INFO: Reading User PIX ile G:/PF_media/pf_lab/pf lab/constraint/fp/my placement.pdc. 0 error(s) and 0 warning(s)
61NF€-1 Reading User PDC file G:/PF_media/pf lab/pf lab/constraint/fp/userl.pdc. 0 error(s) and 0 warning(s)
Info: I0 constraints were written to file G:/PF_media/pf_lab/pf lab/constraint/io/pre/tmp_extra_cst_528463.pdc
: New placement constraints were written to file
013: No £ ible dedi

T PLL 0/txpll isnt_0
CIESS LANE3 Pipe BXI1

olarFire connectivity

d connection exists between pin BIT_CLK of i
f instance 'my p

{2466,236) and pin REF CLK P of
{2460,317). You mast place these

Note: I/0 assignments can be made for REFCLK, TXPLL, and Transceiver Lanes for all Transceiver
protocols except the PCle Protocol. For the PCle Protocol, Transceiver Lanes are assigned to
predefined locations and cannot be removed.

7.4. Transmit PLL Assignment (asa question)

Drag and drop the Transmit PLL instance into the desired location. Illegal locations are flagged with
error messages in the Log window and the illegal connections are indicated by red lines.
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Figure 7-9. lllegal Transmit PLL to Lane Assignment
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The Log window displays two error messages about the illegal assignments, one for each illegal
connection. In this case, the assignment is illegal because there are no feasible dedicated
connections.

Figure 7-10. Log Window

Log @
iMessages QErrors 4. Warnings 0Info

OINF\’}: Reading User PDC file G:/PF media/pf lab/pf lab/constraint/ioc/user.pdc. 0 error(s) and 0 warning(s)
INFO: Reading User PDC file G:/PF media/pf lab/pf lab/constraint/io/tmp extra cst_528463.pdc. 0 error(s) and 0
warning(s)

INFO: Reading User PDC file G:/PF media/pf lab/pf lab/constraint/fp/my placement.pdc. 0 errcor(s) and 0 warning(s)

INFO: Reading User PDC file G:/PF media/pf lab/pf lab/constraint/fp/userl.pdc. 0 error(s) and 0 warning(s)

Info: I0 constraints were written to file G:/PF_media/pf lab/pf lab/constraint/io/pre/tmp extra cst 528463.pdc
fo: New placemem: constraints were written to file

dedicated connection exists b
(239) and pin TX BIT CLK 0

n (2463,236). You must place these instances a

n pin BIT ¢ “L[" of inatance ' IX PLL O0/txpll_isnt 0

7.5. Placement DRC Rules (aska question)

The I/0 Editor enforces the DRC rules when Transceivers are placed. Any illegal connection is
highlighted as a red line in the Placement View and a corresponding message is displayed in the Log
window.

Lane assignments are always legal. DRC rules are enforced for the following:

« Connection from Transmit PLL (TXPLL) to the Lanes
+ Connection from the Reference Clock (REFCLK) to the Transmit PLL (TXPLL)
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« Connection from the Reference Clock (REFCLK) to the Lanes

7.5.1. DRC—TXPLL to LANES Connectivity (askaauestion)
A TXPLL_SSC can connect to all the lanes of a quad (shown in brown lines in the Placement View).

Figure 7-11. TXPLL Connection To All Four Lanes Before Placement
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Figure 7-12. TXPLL Connection To All Four Lanes After Placement
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A TXPLL (non-SSC) can connect to two lanes beside it normally (shown in blue lines in the Placement

View).

Figure 7-13. TXPLL Connection To Two Lanes (Before Placement)
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Figure 7-14. TXPLL Connection To Two Lanes (After Placement)
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Figure 7-15. Q1_TXPLL1 to Four Lanes Connection (Before Placement)
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Figure 7-16. Q1_TXPLL1 to Four Lanes Connection (After Placement)
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7.5.2. DRC—REFCLK to TXPLL conneCﬁVity (Ask a Question)

A REFCLK can connect to all the TXPLLs beside and below it (down the Cascade Path) in the

F R (G32,G31)

Placement View. A REFCLK cannot connect to a TXPLL above it (up the Cascade Path).

A cascade path (represented by the vertical line beside the REFCLKS) is used for the REFCLK to

connect to all the TXPLLs below it and the Lanes below it in the Placement View.
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Figure 7-17. lllegal Connection From REFCLK to TXPLL Up the Cascade Path
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7.5.3. REFCLK to Lanes Connectivity (aska question)

The REFCLK of a quad can connect to all Lanes of the TXPLL (in addition to that which the REFCLK
can connect), as well as all the other Lanes below it (including from different quads). Connection up
the Cascade path is illegal.

Green arrows indicate legal connection and red arrows indicate illegal connection from the REFCLK
to the Lanes.

Figure 7-18. REFCLK to Lanes Connection—Legal (Down the Cascade Path) and lllegal (Up the Cascade Path)
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8.1.

IO D VieW (Ask a Question)

The IOD lane controller handles the complex operations necessary for the high-speed interfaces,
such as DDR memory interfaces and CDR interfaces. To bridge the lane clock to the bank clock, the
lane controller is used to control an I/0 FIFO in each IOD. This I/O FIFO interfaces with DDR memory
by utilizing the DQS strobe on the lane clock. The lane controller can also delay the lane clock using
a PVT—calculated delay code from the DLL to provide a 90° shift. Certain I/0 interfaces require a
lane controller to handle the clock-domain that results with higher gear ratios.

The lane controller also provides the functionality for the IOD CDR. Using the four phases from

the CCC PLL, the lane controller creates eight phases and selects the proper phase for the current
input condition with the input data. A divided-down version of the recovered clock is provided to the
fabric (DIVCLK).

In the 1/0 Editor, the IOD View allows I/0 assignments for IOD (I/O Digital) Interface blocks. Libero
SoC currently supports CDR and RX_DDR_L_A/TX_DDR_G_A generic IOD interface. Future releases
will add in more interfaces. The 10D views presents a hierarchical view of the generic |IOD based on
Bank and Lanes. In PolarFire silicon, there may be up to eight banks per chip and six lanes per bank.
Bigger dies may have even more lanes per bank.

Note: The actual number of banks and the number of lanes per bank vary with the die.

When the 1/0 Editor opens the IOD view, it detects the specific IOD Interface standards, groups the
I/0s into specific banks/lanes and populates the spreadsheet-like table with the I/0 names (specific
to the 10D Interface) accordingly.

See the following figure for an example of the 10D View.

Figure 8-1. I0OD View
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Generic 1/0 Assignments (asa question)

Drag the I/0 port from the Ports tab and drop it to the spreadsheet-like table to make the 1/0
assignment. The multi-line comment shows the locations where you can legally place the I/0 port.
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Green indicates legal placements, and red indicates illegal placements. lllegal assignments are not
allowed.

8.2. DRC RUIeS (Ask a Question)

The I/0 Editor enforces the following list of common Design Rules Check (DRC) rules:

All I/0s of the same logical lane must be placed within the same physical lane.

For any one physical lane, only one logical lane is allowed to be placed.

Non-logical lane 1/0s can be placed in any physical lane.

For RGMII Interface, the *_RXC port must be placed on the CLKIN_S_* side of the physical lane.

When the CDR is placed in a physical lane, the DQS_N slot is reserved and is not available for I1/0
placement.

For more information on DRC rules for the 10D I/0 placement, see the PolarFire FPGA and PolarFire
SoC FPGA User I/0 User Guide.
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9. Floorplanner View (s question)

The Floorplanner View displays all design elements in one window. The selections you make in the
views are reflected in the window. The color scheme used in the canvas is dependent on the layers
and colors you have selected in the Display Options window.

The following figure shows the Floorplanner View.

Figure 9-1. Floorplanner View
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9.1. Operating Modes (aska question)

The Floorplanner View has two operating modes. Click the Macro Manipulation Mode button to
switch between Macro Manipulation Mode and Region Manipulation modes:

+ Macro Manipulation Mode. Use this mode to work with macros, such as assigning macros to
location or unassigning placed macros from locations. You can also view properties of selected
macros in the Floorplanner View from the properties window. You can select multiple macros by
pressing the CTRL key and selecting required macros.

* Region Manipulation Mode. Use this mode to work on regions such as resizing, renaming, or
deleting regions, or assigning and unassigning macros or nets to regions.

9.1.1. Display Modes (Ask a Question)

The Display Options window allows you to customize the layout and the color settings for design
elements on the Floorplanner View to meet your personal preferences.

There are three default layers and colors settings group:
+ System

* Pin_Planner

+ Grey_Scale

You can also see the colors for different component types (nets, modules, pins, and so on) in the
Display Options window.

9.1.1.1. Selection (aska question)
Clicking an item selects that one object in the model. However, you can select multiple items:

+ To select contiguous items, click the first item you want to select, and then hold down the
Shift key and click the last item you want to select. All items between the two are selected
automatically.
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9.1.1.2.

+ To select items that are not contiguous. click the first item. Then hold down the Ctrl key and click
each additional item you want to select.

If you selected multiple items and then change your mind about a selected item, you can deselect
the item by holding down the Ctrl key and clicking the item.

Selections follow a symmetrical behavior: If you select a port, all macros attached to it are selected
as well. Similarly, if you select a pin object, all corresponding macro objects are also selected.

For example, if you select a port, the macro is also shown as selected. However, the property page
still points to the port. Pin selection follows the same behavior.

Highlighting (Ask a Question)
The Highlighting option allows you to set persistent colors on designated macros, nets, or both
across the system.

To set a highlight, go to the Logical Object Browser or the Net Object Browser, select one or more
macros and/or components, and click the pencil icon as shown in the following toolbar.

Figure 9-2. Pencil and Eraser Icons

When you set a highlight, all selected macros, ports, and/or nets in the design are marked with the
selected color. The selected color appears in the left object browser tree. The following figure shows
the left Main Object Browser with the logical tree displayed. To select both components, click one
component, hold down the Ctrl key and click the other component.

Figure 9-3. Example of Highlighting Shown in the Object Browser Tree
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The color remains until you select one of the two middle eraser icons:
+ The left eraser icon removes all highlights.

+ Theright eraser icon removes highlights only from selected items.

To set the highlights, use the Current Highlight check box from the Design Settings docking
window. Below this check box are an Auto Rotate check box, along with eight Highlight check
boxes and radio buttons.

+ Use the Highlight check boxes to enable or disable a highlight. Separate check boxes are
provided for macros and nets.
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+ Use the Highlight radio buttons to designate which highlight is active.
Note: You cannot disable the active highlight.

Figure 9-4. Design Settings Docking Window
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Clicking the colored box next to each check box allows you to select a color for that macro or net.

The following figure shows an example of the results when all options under Nets are exposed.

Figure 9-5. Example of Exposing All Nets
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If Net Settings is not checked, all nets in the system, except cross-probe nets, are disabled. All
options subordinate to that option are marked with a gray box to show that the option is not used.
If Show Nets for Highlighted Macros is not checked, all net options inside the currently highlighted
net selections are disabled. To restore the color of these options, check the individual options. If
you check Show Nets for Highlighted Macros, the individual settings in the highlight settings area
determine whether nets will be drawn.

Note: If you enable Auto Rotate and Net under Auto Rotate, and then uncheck the check box in
the Net color selection, the net color in the Net view is not consistent with that of the Planner.

The Consolidate Globals option converts the raw clock display with globals connected to locals as if
the sum of the local nets and the global nets are the same net. This is for display purposes only.

The bottom three options in the Design Settings docking window work with groups of macros and
ports for which you consider net lines as a single entity:

@ MICROCHIP



+ Show Interior Nets for Selected/Highlighted Macros shows lines that connect two different
macros in the group.

+ Show Input Nets for Selected/Highlighted Macros shows lines that connect an output port of
an exterior macro to one or more input pins in the group.

+ Show Driver Nets for Selected/Highlighted Macros shows drivers in the group that connect
with an exterior macro.

9.1.1.3. Cross Probing (aska question)

9.1.2.

When an external application performs a cross probe, the elements colored for cross probing and
cross probe nets are always displayed. There are no options that allow cross probing to be disabled
or turned off; however, you can change the cross probing color to transparent.

Any additional cross probes get added to the current ones. To clear a cross probe state, use the
rightmost eraser icon in the following toolbar.

Figure 9-6. Pencil and Eraser Icons

Floorplanner View Icons (aska question)

The icons available across the top of the Floorplanner View window allows you to zoom in, zoom
out, assign I/0 banks, runs DRC checks, and create regions for placement.

The following figure shows floorplanner view icons.

Figure 9-7. Floorplanner View Icons
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The following table lists the functions of each icon.

Table 9-1. Floorplanner View Icons

s Rubber Band Zoom Rubber Band Zoom - Drags out an area to enlarge/zoom into.
=
— Rubber Band Select Rubber Band Select an area to Zoom into. Click in the Floorplanner View and drag
kf;‘\ the mouse to delineate an area. Release the mouse and all macros inside the
delineated area are selected.
Works in the Macro Manipulation Mode.
: Zoom In Zoom In to canvas.
(+)
%
= Zoom Out Zoom Out of canvas.
g’
s Zoom to Fit Zoom to fit the canvas size.
Lo
v
Zoom to Location Zoom to a Location Specified by X-Y co-ordinates.
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Table 9-1. Floorplanner View Icons (continued)

z—-_
(5)
=%

#

0

Zoom to fit Selection

Check Design Rules

Check DRC Rules for Selected
Interfaces

I/0 Bank Settings

Auto Assign 1/0 Bank
Collapse Visible Views
Expand Selected Items in

Visible Views

Create Empty

Create Inclusive

Create Exclusive

Delete

Show Nets For Macros

Zoom to fit selected macros and ports. When enabled, the view attempts to center
the view on the selected and placed ports.

Run the Prelayout Checker, a preliminary check of the netlist for possible Place and
Route issues.

Check the DRC Rules for selected interfaces.

Set the I/0 bank to specific I/0 Technology.

Run the Auto I/0 Bank and Globals Assigner. Assigns a voltage to every I/0 Bank
that does not have a voltage assigned to it and if required, a VREF pin.

Collapse the visible views.

Expand selected Items in the visible views.

Create an empty user region.

Create an inclusive user region.

Create an Exclusive user region.

Delete the selected user region.

Show all nets connected to the macro. There are often many nets attached to the
macro, and it is off by default.

An object or a collection of the objects in the Design View window can be selected and placed in any
location that is legal.

The following figure shows an example of a successful placement into the Floorplanner View.
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Figure 9-8. Floorplanner View—Successful Placement

The following figure shows an example of an unsuccessful placement attempt into the Floorplanner
View.

Figure 9-9. Floorplanner View - Unsuccessful Placement Attempt
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9.1.3. Region Assignments (ask a Question)
When you right click an item in one of the tabs in the Main Object Browser, you can choose from
available options, which can include placing an item to a location, unplacing an item from a location,
locking the placement, and assigning a region.

Multiple items can be selected and assigned to the same region at the same time. You can also
select a region assignment by right clicking an item and choosing Region Assign. The dialog box
opens as shown in the following figure. This option is not available for objects in the Region tab.
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9.2.

9.2.1.

Figure 9-10. Select Region Dialog Box
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The progress of All Region Assign and Unassign commands is as shown in the following figure.
Figure 9-11. Progress of All Region Assign and Unassign Commands

7| ChipPlanner 7| 3]
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Note: This dialog shows only the progress, and does not allow the user to cancel the operation.
Closing the dialog does not terminate the operation.

Netlist Views (Ask a Question)

Two windows are available for viewing the netlist (a schematic view of the design used to trace the
nets and debug) of the design.

+ Post-Synthesis Hierarchical View (Netlist Viewer - Hier)
+ Post-compile flattened Netlist View (Netlist Viewer - Flat)

Separate tabs for Hierarchical View and Flattened Netlist View make it easy to switch between the
different views.

Netlist Viewer—Hier (ask a question)

The Post-Synthesis Hierarchical View (Netlist Viewer—Hier) is a hierarchical view of the netlist after
synthesis and after technology mapping to the Microchip FPGA technology. Click on the Canvas

to load the "Hierarchical view" in Nelist Viewer—Hier. The Chip Planner loads the netlist into the
system memory and displays it in the window.

When the netlist is loaded for the first time into memory, a pop-up progress bar indicates the
progress of the loading process, which may incur some runtime penalty for a large netlist.
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Figure 9-12. Netlist Viewer—Hier View
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9.2.2. Netlist Viewer—Flat (Ask a Question)

This is the flattened (non-hierarchical) netlist generated after synthesis, technology mapping and
further optimization based on the DRC rules of the device family and/or die. Click on the Canvas to
load the "Flat" view in the Netlist Viewer—Flat window. The Chip Planner loads the netlist into the
system memory and displays it in the window as shown in the following figure.

Figure 9-13. Netlist Viewer—Flat View (Flattened Netlist)
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9.2.2.1. Display Across Multiple Pages (aska question)

Hierarchical or flattened netlists can span multiple pages, in which case the first page is displayed
when it opens.
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The current page number and the total number of pages are displayed in the status bar at the lower
right corner of the window.

Figure 9-14. Status Bar

Mode: Global | Current Level: top I:'I'i.]F'.].l Current Page: 1 of 2173
To go to different pages of the Netlist view, use the left-pointing arrow:

4

to differs

>

or the right-pointing arrow:

9.2.3. Netlist Viewer Features (ask a question)
See the Netlist Viewer User Guide for details about Netlist Viewer features.

9.2.4. Chip Planner Features (aska question)
See the Chip Planner User Guide for details about Chip Planner features.
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10.
10.1.

10.2.

10.3.

Other I/O Editor WindOWS (Ask a Question)

W0r|d VieW WindOW (Ask a Question)

The World View shows a red rectangle which reflects what is visible in the Floorplanner View in the
context of the die. Changing what is visible in the canvas also changes the red rectangle. Changing
the size or position of the red rectangle changes what is seen in the Floorplanner View.

Figure 10-1. World View Window

World View & X

Log WindOW (Ask a Question)

The Log window displays all messages generated by /0 Editor. You can filter the messages
according to the type of message: Error, Warning, and Info. If you have made and saved changes
in 1/0 Editor, the Log window displays the name and location of the PDC file(s) which have been
edited/updated to reflect the changes.

Figure 10-2. Log Window

Log |§|

jMessages &3 Errors_§, Warnings i Info

OINFD: Reading User PDC file D:/2Work/g5S romii sgmii ddr 7/constraint/iofuser.pdc. 0 error(s) and 0
warning(s)

INFO: Reading User PDC file D:/2Work/g5 romii sgmii ddr 7/constraint/fp/user.pdc. 0 error(s) and 0
warning(s)

0" must be assigned to "AK3

Object WindOW (Ask a Question)
The Object window (Main Object Browser) includes the following tabs:

+ Port

+ Logical
* Net

* Region

Press Ctrl+F to open a floating window for the active tab. See the following example.
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10.4.

10.5.

Figure 10-3. Floating Object Window Tab Example

Main Object Browser F X
| Qv
Ports | i'.‘_.-*_‘t_l | t
. £} /O Ports

The following table lists the Object window icons.

Table 10-1. Object Window Icons

Collapse everything in the tree.

Expand selected.

Clear the filter and refresh the tree reflecting no filters.
Change sort order and allow additional filtering.

Display Options Window (aska question)

The Display Options window configures the display of the selected view. Three display options are
available as follows:

* Fill Device Cells
* Use Cluster Mode
+ Consolidate Globals

Properties Window (aska question)

The Properties window displays the properties of the design elements. What is displayed in the
Properties window is dependent on what is selected in the design view. Properties displayed may
include the following, depending on the type of design elements:

+ Macro/Component Name—Full Macro or component name based on selection.

+ Cell Type—Resource type based on design element selection.

+ Placed (Location)—X-Y coordinates where device element is placed.

+ Resource Usage Table—A table showing resources based on component and macro selection.

+ Region Attached Table—A table showing region to which selected macro/component is assigned.
« User region (if any) to which it is attached.

+ Nets Table—A table showing pins and nets which is associated with the selected macro along
with fanout value.

+ Locked/Unlocked (Placement)—The selected port is locked or unlocked.
« Port—Port name to which the I/0 macro is assigned (only shown for I/0 port macros).

« 1/0 Technology Standard—I/O Technology which is associated with the selected I/0 macro (only
shown for I/0 port macros).

+ 1/0 Bank—I/0 bank to which the selected I/0 macro is assigned (only shown for I/0 port macros).
+ Pin (Package Pin)—Pin to which the macro is assigned (only shown for I/0 port macros).

Not all properties in the list are displayed. The list of displayed properties varies with the type of
design element selected.
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11. Export PhySiC&' COI’lStraintS (PDC) (Ask a Question)

The 1/0 Editor allows you to export the physical constraints (I1/0 Constraints and Floorplan
Constraints) of the design in a PDC file to any file location on your disk. You can export the User
constraints or the Full constraints of the design. The I/0 PDC files can be exported (File > Export
Physical Constraint (PDC) > I/0 Constraint), as shown in the following figure.

Figure 11-1. Export I/O Constraints PDC File Dialog Box

W7 Export I/0 Constraints PDC File | 7 ” 23 |

File: ]K:fdelete,.’ex 1funtitled. pdc Browse. ..

Constraints can be exported to a POC file for reference.
but must be manually added te an existing POC or
imported via the Constraints Editor for the changes to
aifect the final placed and routed design.

—Choose the type of information you want to Export

¥ |zer Constraints " Full Constraints

oK Cancel

The fp.pdc file can be exported (File > Export Physical Constraint (PDC) > Floorplan Constraint),
as shown in the following figure.

Figure 11-2. Export Floorplanner Constraints PDC File Dialog Box

B ' Export Floorplanner Constraints PDC File ? et

File: ]}ﬁ:fdeletefex 1funtitled. pdd| Browse. ..

Constrainis can be exported to a POC file for reference,
but must be manually added to an existing FOC or
imported vig the Constraints Edftor for the changes to
aifect the final placed and routed design.

—Choose the type of information you want to Export -

{* User Constraints " Full Constraints

ik, Cancel
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12. Appendix (Ask a Question)

This section describes the support for the PolarFire SoC MSS I/0s in the I/0 Editor in Libero SoC
v12.5.

12.1. MSS I/O Placement (Ask a Question)

MSS I/0 placement is done automatically as each port of the MSS has a fixed location on the
package.

12.2. Bank Setﬁngs (Ask a Question)
The following table lists bank settings.

Table 12-1. Bank Settings

Type of Bank Supported Voltages

MSS_IO Bank2 VDDI=1.2
Peripheral I0s VDDI=1.5

VDDI =1.8

VDDI = 2.5

VDDI = 3.3
MSS_IO Bank4 VDDI=1.2
Peripheral 10s VDDI=1.5

VDDI = 1.8

VDDI = 2.5

VDDI = 3.3
MSS_SGMII_IO Bank5 VDDI = 2.5
RefClk and SGMII 10s VDDI=3.3
MSS_DDR_IO Bank6 DDR3.VDDI =1.5
DDR 10s DDR3L. VDDI = 1.35

DDR4. VDDI = 1.2
LPDDR3. VDDI = 1.2
LPDDR4. VDDI = 1.1

12.3. 10STD Support per Type of Bank (asaquestion)
The following table lists the IOSTD support per type of bank.

Table 12-2. |IOSTD Support per Type of Bank

Bank Type 10STDs

MSS_IO LVCMOS12
LVCMOS15

LVCMOS18
LVCMOS25
LVCMOS33
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Table 12-2. |IOSTD Support per Type of Bank (continued)

Bank Type 10STDs

MSS_SGMII_IO LVTTL PCI
LVCMOS33

LVCMOS25

LVCMOS18 SSTL251 SSTL18I

LVDS25

LVPECL33 LVDS33

RSDS25 RSDS33

MINILVDS25 MINILVDS33

SUBLVDS25 SUBLVDS33

PPDS25 PPDS33

LCMDS25 LCMDS33
MSS_DDR_IO SSTL15I

SSTL135I

POD12I

HSTL12I

HSUL12I

LVSTL11I

12.4. Port IOSTD Settings (Ask a Question)

The following table shows how I/0 standards are computed.

Table 12-3. |IOSTD Support per Type of Bank

Peripherals on Bank4 1.2: LVCMOS22
1.5: LVCMOS15

1.8: LVCMOS18

2.5: LVCMOS25

3.3: LVCMOS33
Peripherals on Bank2 1.2: LVCMOS22

1.5: LVCMOS15

1.8: LVCMOS18

2.5: LVCMOS25

3.3: LVCMOS33
REFCLK on Bank5 LVTTL PCI LVCMOS33

LVCMOS25

LVCMOS18

SSTL25I

SSTL18I

LVDS25

LVPECL33
SGMII on Bank5 LVDS25

LVDS33

RSDS25 RSDS33

MINILVDS25 MINILVDS33

SUBLVDS25 SUBLVDS33

PPDS25 PPDS33

LCMDS25 LCMDS33
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12.5.

12.6.

12.7.

12.8.

12.9.

Table 12-3. IOSTD Support per Type of Bank (continued)

DDR I0s on Bank6 DDR3: SSTI15I
DDR3L: SSTL135I

LPDDR3: HSUL12I
LPDDR4: LVSTL11I
DDR4 DQ/DQS/DM: POD12I

Updating the 1/0 Banks and IOSTD (aska question)
Users cannot update the I/0 Bank setting or IOSTD of the MSS 1/Os.

These settings apply to the software side in the XML. They do not affect the Libero project and are
for the user’s reference in ready-only format.

Designs without an MSS Macro (aska auestion)

For designs without an MSS macro, the banks are not set and unlocked. Users can change the
values, but the changes will not affect anything.

Default Bank Settings (aska question)

If there is an MSS macro in the design and some interfaces are not used, this is the default bank
settings that will be used.

Table 12-4. Default Bank Settings

Bank2 VDDI =3.3
Bank4 VDDI =3.3
Bank5 VDDI = 3.3
Banké VDDI = 1.5

PDC Setﬁng (Ask a Question)

A PDC file is not needed for these I/0s because the settings from the MSS Configurator are being
used. If the user specifies a correct placement and I/0 standard, the tool will accept the user’s
settings and will not error-out. But if the user tries to set any of the other specific MSS 1/0 attributes,
it will fail. These constraints will not be written in the generated PDC file from the Chip Planner.

POIarFire SOC MSS I/O Attributes (Ask a Question)

These I/0 attributes are valid only for MSS 1/0s and are read only in the I/0 Editor. These MSS I/0
attributes appear on the right side of the default I/0 attributes and will be visible even when there is
no MSS being used in the design.

Reference Clock
The following table lists the MSS I/0 attributes in the I/0 Editor for Reference CLK.

Table 12-5. MSS 1/0 Attributes and Values for Reference CLK

MSS Resistor Pull None, Up

MSS Clamp Diode OFF, ON

MSS Persist OFF, ON

MSS User I/0 Lock Down OFF, ON

MSS Odt (Ohm) OFF, 100

MSS Thevenin (Ohm) OFF, 150, 75, 50
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Table 12-5. MSS I/0O Attributes and Values for Reference CLK (continued)

MSS Schmitt Trigger OFF, ON
Peripheral 1/Os
The following table lists the MSS I/0 attributes in the I/0 Editor for Peripheral I/Os.

Table 12-6. MSS 1/0 Attributes and Values for Peripheral 1/0s

MSS Resistor Pull None, Up, Down, Hold

MSS Clamp Diode OFF, ON

MSS Persist OFF, ON

MSS User I/0 Lock Down OFF, ON

MSS Schmitt Trigger Schmitt Trigger is always ON for 1.2, 1.5 and 1.8 V I/0 Bank

values. Otherwise, it can be either ON or OFF. The MSS
Schmitt Trigger can have the following values:

OFF, ON
MSS Low Power Mode Input Receiver OFF, ON
MSS Low Power Mode Output Buffer OFF, ON
MSS Output Drive (mA) 1.5,2,3,35,4,6,8,10, 12, 16, 20, 24, 27, 30, 34, 40, 48, 60

DDR I/0s

The following table lists the MSS I/0 attributes in the I/O Editor for DDR I/Os.

Based on the memory type used, the memory types have the following values.

Table 12-7. ODT DQ and ODT DQS Ports

DDR3/DDR3L 120, 60, 40, 30

DDR4 120, 80, 60, 40, 30
LPDDR3 240, 120, 80, 60, 40, 30
LPDDR4 120, 80, 60, 48, 40

Table 12-8. Outdrive for DQ and DM Ports, DQS Ports, CLK Ports, ADD/CMD Ports

DDR3/DDR3L 48, 34,30, 24

DDR4 60, 48, 34, 27

LPDDR3 60, 48, 40, 34

LPDDR4 60, 48, 40, 34
SGMII 1/0s

The following table lists the MSS I/0 attributes in the I/O Editor for SGMII.

Table 12-9. MSS 1/0 Attributes and Values for SGMII

MSS Resistor Pull None, Up, Down, Hold
MSS Odt (Ohm) OFF, 100

MSS Vem Input Range MID, LOW

MSS Source Termination (Ohm) OFF, 100

MSS Output Drive (mA) 1.5,2,3,35,4,6
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13. Revision History s aueston

The revision history describes the changes that were implemented in the document. The changes
are listed by revision, starting with the most current publication.

Q 12/2025 This document is released with Libero SoC Design Suite v2025.2 without changes
from v2025.1.

P 05/2025 The following list of changes is made in revision P of the document:
+ Revised section Slew.

N 08/2024 This document is released with Libero SoC Design Suite v2024.2 without changes
from v2024.1.

M 02/2024 This document is released with Libero SoC Design Suite v2024.1 without changes
from v2023.2.

L 08/2023 Editorial changes. No technical content updates.

K 08/2023 Editorial changes. No technical content updates.

J 04/2023 This document is released with Libero SoC Design Suite v2023.1 without changes
from v2022.3.

H 12/2022 This document is released with Libero SoC Design Suite v2022.3 without changes
from v2022.2.

G 08/2022 This document is released with Libero SoC Design Suite v2022.2 without changes
from v2022.1.

F 04/2022 This document is released with Libero SoC Design Suite v2022.1 without changes
from v2021.3.

E 12/2021 The following list of changes is made in revision E of the document:

+ Updated section User I/0 Lock Down for Port View and Pin View.
+ Added a note for I/0O State in Flash*Freeze Mode and I/0 Available in
Flash*Freeze Mode for Port View and Pin View.
D 08/2021 The following list of changes is made in revision D of the document:
+ Updated section DRC Rules.

C 08/2021 This document is released with Libero 2021.2 SoC Design Suite without changes
from v2021.1.
B 04/2021 The following list of changes is made in revision B of the document:

+ Added Use I/0 Calibration from the Lane section.

11/2020 Document is converted to Microchip format.
8.0 03/2020 The following list of changes is made in revision 8.0 of the document:

* Revised the memory assignments for Memory View to examples such as
DDR3/4,LPDDR3, and QDR

* Revised the supported memory types to DDR3, DDR4, LPDDR3, and QDRI+

7.0 12/2019 The following list of changes is made in revision 7.0 of the document:
+ Updated Resistor Pull information.

6.0 08/2019 The following list of changes is made in revision 6.0 of the document:

+ Updated to reflect latest software changes and added a new chapter about
Export Physical Constraints (PDC).

5.0 12/2018 The following list of changes is made in revision 5.0 of the document:
+ Updated document template and edited and updated text.
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Revision History (continued)

4.0 05/2018 The following list of changes is made in revision 4.0 of the document::
+ Updated I/0 information for Port and Pin Views.
+ Made minor edits for clarification about Package, XCVR, I0D, and
Floorplanner Views.

3.0 10/2017 The following list of changes is made in revision 3.0 of the document::
+ Added new chapter about Floorplanner View.

+ Added new chapter about other windows.

+ Updated I/0 attribute information.

+ Updated figures to reflect new tab order and naming.
+ Added information about Signal Integrity View.

2.0 05/2017 The following list of changes is made in revision 2.0 of the document:
+ Updated Memory View and 10D View and updated graphics.

1.0 01/2017 Initial Revision
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Microchip FPGA Support

Microchip FPGA products group backs its products with various support services, including
Customer Service, Customer Technical Support Center, a website, and worldwide sales offices.
Customers are suggested to visit Microchip online resources prior to contacting support as it is
very likely that their queries have been already answered.

Contact Technical Support Center through the website at www.microchip.com/support. Mention the
FPGA Device Part number, select appropriate case category, and upload design files while creating a
technical support case.

Contact Customer Service for non-technical product support, such as product pricing, product
upgrades, update information, order status, and authorization.

*  From North America, call 800.262.1060
*  From the rest of the world, call 650.318.4460
+ Fax, from anywhere in the world, 650.318.8044

Microchip Information

Trademarks

The “Microchip” name and logo, the “M” logo, and other names, logos, and brands are registered
and unregistered trademarks of Microchip Technology Incorporated or its affiliates and/or
subsidiaries in the United States and/or other countries (“Microchip Trademarks"). Information
regarding Microchip Trademarks can be found at https://www.microchip.com/en-us/about/legal-
information/microchip-trademarks.

ISBN: 979-8-3371-2420-9

Legal Notice

This publication and the information herein may be used only with Microchip products, including

to design, test, and integrate Microchip products with your application. Use of this information

in any other manner violates these terms. Information regarding device applications is provided
only for your convenience and may be superseded by updates. It is your responsibility to ensure
that your application meets with your specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at www.microchip.com/en-us/support/design-help/
client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP “AS IS”. MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY

OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR
PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR

ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO
MICROCHIP FOR THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk,

and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages,
claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any Microchip intellectual property rights unless otherwise stated.
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Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

* Microchip products meet the specifications contained in their particular Microchip Data Sheet.

+ Microchip believes that its family of products is secure when used in the intended manner, within
operating specifications, and under normal conditions.

+ Microchip values and aggressively protects its intellectual property rights. Attempts to breach the
code protection features of Microchip products are strictly prohibited and may violate the Digital
Millennium Copyright Act.

* Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its
code. Code protection does not mean that we are guaranteeing the product is “unbreakable”.
Code protection is constantly evolving. Microchip is committed to continuously improving the
code protection features of our products.
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